CREATING ACCESSIBLE DIGITAL MARKETING

Overview of the concepts that
need to stay front-of-mind as we
create content that is Equally
Accessible by all users.

AN Alison Haynes, Digital Accessibility Compliance Coordinator
PRESENTATION Division of Information Technology
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ACCESSIBILITY IS ABOUT

EXPERIENCE

Have you presented your content CLEANLY and CLEARLY?

Can MANY TYPES of users have a good experience?

Can the user OPERATE and UNDERSTAND your content
easily and in the way they choose?
EouaL
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ACCESSIBILITY IS ABOUT CONTEXT
& EXPERIENCE

Making every digital product accessible by all people in every
environment IS NOT POSSIBLE. You are looking for solutions that
can address as many needs as possible in as many ways as
possible.

Accessibility is not a Boolean function — off/on, white/black,
yes/no. It is a consistently grey area in which we prioritize

compliance with certain standards based on...
Scope
Use
Enterprise priorities
Enterprise values ° "N

N\

..then communicate those standards to creators and users.
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ACCESSIBILITY IS ABOUT CONTEXT
& EXPERIENCE

Labeling a document or other digital content is completely

accessible or completely inaccessible is inaccurate: instead,
my team regularly uses the phrase “MEETS APPROPRIATE
ACCESSIBILITY STANDARDS”

**I'm here to help with setting those standards — in fact, |
prefer that you lean on me for determining those standards so
there is uniformity of messaging across our campuses. **
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ACCESSIBILITY USER

Anyone whose access to information, activities, and/or
environments are impeded by a temporary, recurring, or
permanent condition which impacts their ability to engage in

one or more major life activity, including but not limited to,

» Cognitive, Physical Mobility, Auditory, Verbal, or Ocular
disabilities

» Age, Language, Culture, Education

« Economic position

» Technological aptitude and access

EVERYONE is impacted by one of the above at some point in their
lives and therefore needs accessibility-focused design to thrive.




DESIGNING FOR CERTAIN DISABILITIES
INTRO

Demographics of Student Accessibility Students at Kent State

COMPLIANCE
2021-2022 Students with Disabilities by Category
WCAG P.O.U.R.
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Credit: Assistive Technology
Industry Association
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WHAT IS OUR DIGITAL ACCESSIBILITY POLICY?

It is the policy of the university to make its electronic
and information technologies accessible to all
students, prospective students, employees, guests
and visitors with disabilities, particularly those with
visual, hearing, or manual impairments or who

otherwise require the use of assistive technology to
access information provided through the university's
electronic and information technologies.

Ohio Administrative Code 3342-4-16
https://www.kent.edu/digital-accessibility/policy-overview




WEB CONTENT ACCESSIBILITY GUIDELINES (WCAG)

INTRO
COMPLIANCE Perceivable Operable
WCAG P.O.U.R. Ensuring that everyone is able to Allowing users to operate your
perceive your content even if they access application using a variety of
PERCEIVABLE information in a non-typical way methods and forms of technology
OPERABLE
UNDERSTANDABLE - .
ROBUST |
SASE ST e Text alternatives Alternatives for Keyboard Seizures — avoid
CASE STUDY #2 for non-text audio and video accessible designing content
content content functionality which could
cause a seizure
WEBSITE INFO Distinguishable
tent that Enough time to
CLOSING Adaptable ——
content which can be seen and read or use Navigable — ways
is separate heard content to navigate and

f | / T i
c. Barclays Bank PLC 2016. (inshic - | find content easily
All rights reserved. . @
@ z



WEB CONTENT ACCESSIBILITY GUIDELINES (WCAG)

INTRO
. 4

COMPLIANCE

Understandable

All your content should be

WCAG P.O.U.R.

understandable, clear and concise

PERCEIVABLE
and you should allow users to
OPERABLE explore it at their own pace
UNDERSTANDABLE
ROBUST
CASE STUDY #1 y
Readable Ve Compatible
CASE STUDY #2 simplify text >~ B with other products
content " including assistive
WEBSITE INFO technologies e.g.
screen readers and
CLOSING Input assistance magnifiers Y,
Predictable pages helping users k&\ ¢
which operate in a avoid and correct
consistent way mistakes

IMAGE: c. Barclays Bank PLC
2016. All rights reserved.
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PERCEIVABLE SOLUTIONS - MAKE IT EASIER
FOR USERS TO “SEE” & “HEAR” CONTENT

1. ALT TEXT for images for screen reader users.
A detailed explanation of the visual image which remains hidden to
non-screen reader users.
» Be succinct but specific. Leave out “Image of..." or “Picture of...”

« Some platforms are now using machine learning to generate alt text
but is often misleading and inaccurate. Custom text is always
preferable.

 SEO benefits

« Necessary for images which do not add additional meaning.

TIP: Don't rest on a company’s public assurances that their products
or features are completely accessible. Look in forums and user
reviews for real info or contact us to help you test.




EXPERIENCE-BASED ALT TEXT

Alt-text with no context:
* A mostly empty stadium.

Alt-text on a page about recent
turnout for track tryouts:

« Harvard Stadium with two lone
runners bounding up the steps.

Alt-text on page about renovation
projects:

» Harvard Stadium with cracked
concrete pillars.

RIGHT CLICK when adding Alt-text that is machine-generated:
an image online or look for place outside

“alt text” or “image
description” in the options.
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PERCEIVABLE SOLUTIONS: SOCIAL MEDIA TRENDS

EMOJIS

“Wishing you a prosperous new year excited face with money

symbols for eyes and stuck-out tongue excited face with money
symbols for eyes and stuck-out tongue excited face with money
symbols for eyes and stuck-out tongue excited face with money

symbols for eyes and stuck-out tongue. You guys free tonight?
Give me a call.”

BEST PRACTICES:
Use emojis in moderation
Put them at the end

Never have a call to action
AFTER the emojis
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PERCEIVABLE SOLUTIONS: MORE SOCIAL MEDIA TRENDS

HASHTAGS

Always use Camel Case — the capitalization of the first letter of
each word in a hashtag.

#kentstatestudentsuccess #KentStateStudentSuccess

wepia  Make sure to capitalize the first letter of each word in
hashtags so that the screen reader reads out each word
separately. #ltsEasierToRead

& Everyone canreply

BEST PRACTICES:

Use hashtags in moderation
Put them at the end

Never have a call to action AFTER the hashtags



PERCEIVABLE SOLUTIONS - CAPTIONING
INTRO

COMPLIANCE CAPTIONING — WHY?

* 92% of people watch with the sound off
* Increases watch time by 12%
PERCEIVABLE » SEO advantage — crawlers will read the captions

OPERABLE

WCAG P.O.U.R.

UNDERSTANDABLE
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PERCEIVABLE SOLUTIONS - CAPTIONING
GLOSSARY

CAPTIONING DEFINITIONS:

» Open captions- permanently on the screen. Can block content and
may not be optimized for viewing.

* Closed captions- controlled by the user, can be on or off.

 Captioner — real person who types in the captions and verifies
accuracy

- Automatically generated captions — uses machine learning to
“listen” to the voice and generate text. Generally around 80%
accurate. Resulting captions should be reviewed and/or corrected
before publishing.

* .SRT file - files with this extension indicate they have time-stamped
text to accompany a video. Can use Kaltura Reach to generate .srt
file that can be uploaded with a video on social media and other
communication platforms.




PERCEIVABLE SOLUTIONS - CAPTIONS WHEN

INTRO PRESENTING

COMPLIANCE
WCAG P.O.U.R. CAPTIONING MEETINGS OR EVENTS THAT YOU ARE HOSTING

PERCEIVABLE

* You must enable the captioning on your end — the presenter’s side.
OPERABLE

* You should also verbally alert users to this fact and tell them how to

UNDERSTANDABLE turn on captions if they desire.

ROBUST * Do not use platforms that do not support captioning — this is a

CASE STUDY #1 violation of Kent State policy and creates a huge, waving non-
CASE STUDY #2 compliant flag.

WEBSITE INFO
VIDEOGRAPHY TIP: Make sure that info banners or other important text are not in the lower 10%

CLOSING of the screen for any video. The captions will block the content or vice-versa. For videography,
consider placing the subject in the center of the remaining 90% rather than aligned center vertically.
Consider a wider shot of the main speaker to allow for banners at the top and captions at the bottom.
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PERCEIVABLE SOLUTIONS - CAPTIONS WHEN PRESENTING

CAPTIONING MEETINGS OR EVENTS THAT YOU ARE HOSTING

* You must enable the captioning on your end — the presenter’s side.

 You should also verbally alert users to this fact and tell them how to turn on
captions if they desire.

* Do not use platforms that do not support captioning - this is a violation of Kent
State policy and creates a huge, waving non-compliant flag.

VIDEOGRAPHY TIP: Make sure that info banners or other important text are not in the lower
10% of the screen for any video. The captions will block the content or vice-versa. For
videography, consider placing the subject in the center of the remaining 90% rather than aligned
center vertically. Consider a wider shot of the main speaker to allow for banners at the top and
captions at the bottom to not overlap onto the speaker’s head.
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PERCEIVABLE SOLUTIONS - CAPTIONING
TAKEAWAY

— Always have captioning available for any KSU sponsored
marketing/information/event.

—Announce at the beginning how the captioning can be
activated and iterate your unit or KSU's commitment to
accessibility. (We can share verbiage with you!)

—|f event has large viewing potential, hire an ASL interpreter.

—Even for “smaller” events, choose to make a statement by
scheduling an interpreter.

If a Deaf user/s make a request, or if you're open to a wide audience where Deaf
people might attend, you'll want to use certified interpreters. If it's a medium-sized
audience and there aren't requests, Prof. Jamie McCartney’s students are a great, free
option.
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COLOR CONTRAST

WCAG states that the
contrast between
foreground and
background of any two

colors must be at least
4.5:1.

SOCIAL MEDIA TIP: Choose
background colors

wisely. Facebook offers
several colorful and
decorative backgrounds.
Make sure to choose a dark
solid color. The backgrounds
with lots of detail and those
with gradient may make your
posts difficult to read.

#FFFFFF

#FCD872

#4A90E2

#FC36FD

#5D3FDA

#F35369

H66F485

#17ACFF

#5F6673

CONTRAST RATIO

1.38

3.29

2.96

6.59

3.36

1.41

2.51

5.78

LARGE TEXT

Naw

AA

Naw

AAA

AA

Naw

Naw

AAA

SMALL TEXT

Naw

Naw

Naw

AA

Naw

Naw

Naw

AA



PERCEIVABLE SOLUTIONS: COLOR CONTRAST

INTRO
For an image or meme to be accessible, visibility of the text in the image is
COMPLIANCE :
very important. Make sure the background color and foreground colors
WCAG P.O.U.R. provide good contrast.
PERCEIVABLE BEST PRACTICES:
OPERABLE Put a box behind text if you must use a busy background.
UNDERSTANDABLE Darken the background and lighten the text (foreground) or vice versa.
ROBUST
CASE STUDY #1
CASE STUDY #2

mn is a second

| : | Autumn is a second spring when
WEBSITE INFO sprifigavhen every leaf is R b 16 o Mowe
ower.
CLOSING ~ <. Albert Camus
R wm\ .
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PERCEIVABLE SOLUTIONS: SPACING & STYLING

People with low vision, dyslexia, and cognitive
disabilities require increased space between lines, words,
and letters.

Better spacing helps with discernment of sections and
calls to action, especially the internalization or retention
of those CTAs.

Use bolding and/or CAPITALIZATION to draw the user’s
eye directly to the key pieces of information.
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PERCEIVABLE SOLUTIONS: SPACING & STYLING EXAMPLES

Digital Marketing

Perceivable Solutions

Operable Solutions

Understandable Solutions
Robust Solutions

Accessible Marketing Checklist

ACCESSIBLE MARKETING

Kent Digital Accessibility Help Topics Digital Marketing

Accompanying Virtual Training: Creating Accessible Marketing & Social Media

Please email ahayne23@kent.edu to discuss personalized workshops for your team

DIGITAL MARKETING includes a dizzying amount of media
types: videos, graphics, blogs, social media, infographics, content
marketing, paid advertising, search engine optimization,
catalogs, exhibits...

Rather than show step-by-step instructions for every platform and operating system (which are
constantly changing), we're going to share CONCEPTS that you can DRAG & DROP onto any digital

marketing project.

Accessibility Concepts for Digital Marketing

Designing and deploying accessible content starts with thinking through the CONTEXT and EXPERIENCE your user might have. Where will they be? What

will they be viewing your content on? Can they control playback or captioning?

Study the concepts in the two images below, then choose a specific accessibility issue to learn its digital marketing application. We've grouped all

marketing content using the WCAG abbreviation PO.U.R. (Perceivable, Operable, Understandable, Robust), hoping this helps you retain principles that can

be applied to any content creation.

ACCESSIBILITY IS ABOUT




PERCEIVABLE SOLUTIONS: SPACING & STYLING EXAMPLES

STEPS TO CREATING AN ACCESSIBLEETD

INTRO

Equal Access = Essential for Some. Useful for All.

COMPLIANCE

A Partnership Between Kent State University Libraries and the Digital Accessibility Team

Thank you, graduate student, for your efforts to upload accessible ETDs. You are joining thousands of other students across

Ohio working to comply with state and federal standards for academic resources, therefore ensuring Equal Access to the results
WCA G P. O ° U. R ° of your hard work and academic discipline for ALL future readers! Below are the steps you’ll need to follow.
PREPARE YOUR SOURCE DOC IN WORD

EER CEI VA BL E m 1. Check each of your figure descriptions (captions) of images, graphs, formulas, or charts. If you

have completely explained the visual elements of the figure in its description and/or
surrounding paragraphs, you do not need to create separate alt text.

2. Complete ALL edits before converting to PDF. Creating the PDF and checking it for
accessibility should be the FINAL STEP in preparing your ETD for submission.

OPERABLE

EXPORT FROM WORD AS A PDF

1. Select File > Save As or File > Save a Copy.
In the Save As dialog box, choose the File Type > PDF then select Options*.

Select the Document Structure Tags for Accessibility checkbox, and then select OK.
*NOTE: If Options is not available on the Save dialog box, look for a selection under the file
format box that reads“Best for electronic distribution and accessibility” and check that.

UNDERSTANDABLE

0.

ROBUST

REVIEW THE ACCESSIBILITY OF YOUR PDF

1. Open PDF in Adobe Acrobat PRO. Click the Tools tab in the upper left of the document. Scroll
down to the section Protect & Standardize and open Accessibilitv

2. Choose Set Alternate Text on the Accessibility toolbar and (if you

descriptions as explained above) check Mark as Decorative for e CORRECT CHOICES FOR ACCESSIBILITYDIALOG BOXES

CA SE S TUD Y #2 3 g:iﬂ:(:i::tl—e;;d Accessibility toolbar, click Accessibility Check

select where your accessibility report will save (best practice is th

CASE STUDY #1

&3

saving your working thesis or dissertation). ( °® Accassibility Olveciar Options
WEBSI TE INFO 4. REVIEW PAGE TWO/REVERSE OF THIS DOCUMENT to choose th _
dialog box BEFORE you click Start Checking (Figure 1). After maki R.E’p"” Lo
. . L4 Create accessibility report
Sletfha G iecking bution. —_ Figure 1: Accessibility Report Dialog Box
Folder: {Usersfahayne23/Documents/ ( Choose... |
CL OSIN G Attach report to document ‘ In REPORT OPTIONS section, click:
Page Range Create accessibility report
‘ © All pages in document () Pages from 1 to |1 ‘ Attach report to document

Checking Options (27 of 32 in all categories)

In PAGE RANGE section, click:
© All pages in document

Category: [ Document a]

Accessibility permission flag is set

In CHECKING OPTIONS section, click ONLY:
Accessibility permission flag is set

Document is not image-only PDF

[[J Document is tagged PDF
[C] Document structure provides a logical reading order Document iS not image'only PDF




INTRO

COMPLIANCE

WCAG P.O.U.R.
PERCEIVABLE
OPERABLE
UNDERSTANDABLE

ROBUST

CASE STUDY #1
CASE STUDY #2
WEBSITE INFO
CLOSING

OPERABLE SOLUTIONS: GIVE USERS ENOUGH TIME TO
READ AND USE CONTENT

* Pause, Stop, Hide:

Moving, blinking, scrolling: For any moving, blinking or
scrolling information that (1) starts automatically, (2) lasts
more than five seconds, and (3) is presented in parallel with
other content, there is a mechanism for the user to pause,
stop, or hide it.

* Do not use content that causes seizures or physical

reactions.
No more than three (3) flashes per second

TIP: Be careful when choosing animations for social media
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OPERABLE SOLUTIONS: NAVIGATING LINKS

* Help users navigate and find content.

WCAG guideline 2.4.4, Link Purpose (In Context) Level A: The
purpose of each link can be determined from the link text
alone.

* Phrases such as "click here," "more," "click for details," and so
oh are ambiguous when read out of context

* Screen readers can speak a list of links — how would a user find
the correct one if they are all labeled “click here”?



UNDERSTANDABLE: MAKE TEXT READABLE, UNDERSTANDABLE &
RETAINABLE

INTRO

Some people use the word “retarded”
or “stupid” when they mean:

COMPLIANCE » As you create content, stay aware of ALL users’ A SRS

attention spans. They are short! e Irritating e Obnoxious
WCAG P.O.U.R.

Some people use the word “spaz”
or “retarded” when they mean:

TIP: Create an email or graphic then use a tool to
PERCEIVABLE T grap \ IR v Bl
count the words. See if you can reduce the word e |
e Cheesy e Nonsensical
OPERABLE count by 20%
Some people use “insane” or
“crazy” when they mean:
UNDERSTANDABLE e AVOID: e Intense e Awesome
e A Ir e Wild
ROBUST — Lengthy event explanations . R:;ij 2 . E;Lromely
— Wordy paragraphs e Wicked
CASE STUDY #1 — Jargon or language above a 5t grade reading level. (even at Some people use “lame” when they mean:
a university? Yes.) e Bad asAGEE
CASE STUDY #2 — Ableist language: any word or phrase that devalues people * Uncool * Unpleasant
who have a dlsablllty Though Oftgn in.adV?Ijt.ent, ableist Some people use crazy when they mean:
WEBSITE INFO language suggests that people with disabilities are o Shodking T
abnormal. e Unbelievable e Ridiculous
CLOSING > e QOverwhelming e Bizarre

Some people use “psychopath” or
“sociopath” when they mean:

* Dangerous * Menacing
* Threatening * Frightening




ROBUST: MAXIMIZE COMPATIBILITY WITH

INTRO CURRENT AND FUTURE USER TOOLS
COMPLIANCE

This category of guidelines refers to making sure that your pro instafonts instajonts Ins T alF M Nts

. - nstafonty  inslafonls  INStqfonts
compatible with reasonably outdated, current, AND future tech ; 2 oo 570 stafonts

WCAG P.O.U.R.

insta geknt ?.;ngds s,

EER CEI VA BLE . . 'ZSE; You thinkit's cuw e to write your tweets and usernames

The applICathnS for us are: )V“ 41 this way. But have you listened to what it sounds like

FONT with assistive technologies like 7ozceOve»?

OPERABLE « If you are using a digital product which - [ICEREEESSSS
TQ@)-

UNDERSTANDABLE has layout templates, use those rather than B e

. | ' n ': assistive technologies like 7oz ceOGuver?
creating a new layout. Often, the templates have *
ROBUST b ] B O @

more built-in accessibility than starting from scratch.

X edit text You think it's ¢« to write your tweets and usernames
this way. But have you listened to what it sounds like with assistive

CASE STUDY #1 Examples: Drupal, Marketing Cloud, Outlook Emails, etc. S e
Less customization often = greater accessibility ool s
CASE STUDY #2 . . . . 1:49 PM - Jan 9, 2019 - Twitter Web App
- If you are working within a platform which doesn't allow much . =
WEBSITE INFO stylistic freedom with fonts (twitter, facebook, Instagram), don't
CLOSING compensate by using Unicode fonts.
]

E=QUA

CCESS




© Miranda Sepulveda <msepulv2@kent.edu> Monday, September 19, 2022 at 4:38 PM
To: @ Haynes, Alison

Created by: Trombka, James <jtrombka@kent.edu>
Contact: James Trombka <jtrombka@kent.edu>
Department: Student Accessibility Services

Q. In your own words, describe the event/program/service:

A. Color of Calmness is another event that is part of Disability Awareness Month. Students will be able to come to various locations
throughout the month and de-stress by coloring. Coloring materials will be provided by SAS. The event will take place multiple times
throughout the month so | would like for the 3 dates/times to be listed on the posters & graphics. We're still waiting on confirmation of a
location for the event at the end of the month, but | will get that info sent over as soon as | have it.

Q. Copy to include:

A. Color for Calmness

Monday, October 10

1-3pm.

SAS Conference Room (KSU Library 135)

Tuesday, October 18
1-3p.m.
Student Recreation & Wellness Center Lobby

Wednesday, October 26
1-3p.m.
Location TBD

Take time out of your busy day to relax and color in a clamming, low-stress environment. Coloring matel




o 8 v

(if* Kent State University Golden
=== Flashes

January 13 at 5:30 PM -
Join us tomorrow night in the MACC for a
GOLD OUT  against Akron!

@ https://bit.ly/315C40b

#GoFlashes

O 22 2 Comments 2 Shares

o) Like (J Comment > Share I -
Most relevant -

(e L

0 Dwight E Garner

Let's Go Kent State .... time to get
back to WINNING

Like - Reply - 6d

I‘\ Write a comment... ©) [©@) ¥

WAGON WHEEL

CHALLENGE

N 0909




. Kent State University Golden
" Flashes
January 13 at 5:30 PM - &
Join us tomorrow night in the MACC for a
GOLD OUT  against Akron!

@ https://bit.ly/3I15C40b

#GoFlashes

2 Comments

2 Shares

y AR

(D Comment > Share @~

Most relevant -

Dwight E Garner
Let's Go Kent State .... time to get

back to WINNING

Like - Reply - 6d

Write a comment...

JAN14 | 8 PM
M.AQCQC.

]IS
@ CRYSTAL CUNIC

WAGON WHEEL

CHAIPLLENGDGE

® . * O - o




Q iz
WE'RE 6T o BLOGD‘

UNIVERSITY
..TO SAVE LIVes

ifferen

ﬁm h WEDNESDAY OCTORER STH

12PM TO 4PM

o
Youz Dcmrfcu uling ﬁ, \ppointment ohead
COULD SAVE S of time is recommended. To schedule
LIVES! COME your ap| omtment online, please visit
and enter sponsor
code KSUMAIN hoose the locatio
T % and book from the available time:

o) ] aumat
81 toalf ent State students, facully: staft, e

CENTER FOR
INDER-

GRADUATE

EXCELI.ENCE

BOWMAN
HALL

Additional academic resources are available
ACROSS SUMMIT ST IN THE SCHWARTZ CENTER.
Check the map for the quickest route.

el
\-\omecomlng Iniemahonq,

p Celebration:
Friday, September 30
57 PM

Student Green *

Available resources are housed upstairs in
MICHAEL

Suite 2671 and include the following: SCHWARTZ
CENTER

Career Exploration and Development

University Advising and Degree Completion | """ "r=w==-eo

Y You Are Here : Quickest Route Q Destination




Leadership Development

A leadership resource designed for students to access anytime and
anywhere! Customizable and self-paced to fit your individual needs.
Whether you're looking to strengthen a specific skill

or to improve overall leadership development.

Email lead@kent.edu for more information,

or message @kentstateleads on social.

KENT STATE. -

Center for Student
Involvement

Ciwinion of Student Al ainy
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Learn to be a better leader on your own time Va?

A leadership resource designed for [=] 232 [m]
- 3

students to access ANYTIME
and ANYWHERE! Enroll today!




S 1T Y Center for Student Involvement

Get Involved Leadership Center Student Organizations Resources Meet Our Staff Contact Us Donate

LEADERSHIP DEVELOPMENT CANVAS MODULES

Get Involved _
Kent Center For Student Involvement Leadership Development Canvas Modules

OO (O This new leadership resource is designed for students to access anytime and anywhere! Our

Student Organizations new leadership development canvas modules are designed to provide students with a

S customizable, self-paced experience to fit their individual needs. Whether you are looking for a

specific skill to strengthen, or are looking to complete all modules for overall leadership

Meet Our Staff _
development, we have something for you!

Contact Us
Emalil lead@kent.edu for more information.

ENROLL TODAY!

Donate




Leadership Development

A leadership resource designed for students to access anytime and
anywhere! Customizable and self-paced to fit your individual needs.
Whether you're looking to strengthen a specific skill or

to improve overall leadership development.

Email lead@kent.edu for more information,
or message @kentstateleads on social.
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120 views

@m & Want to improve your leadership skills? Enroll
in the Leadership Development Canvas Module!

v
Learn to be a better ‘. ° .‘

leader on your own time
g . Nar
Try our new Leadership

Development Canvas Modules

A leadership resource designed for
students to access ANYTIME
and ANYWHERE! Enroll today!

WWW.KENT.EDU/CSI/CANVAS
KENTSATE. - @ |

120 views

Learn to be a better leader on our OWN time! Get started

by enrolling in the Leadership Development Canvas
module! Link in our bio to enroll. & ¢
#Canvas #KentStateLeads #KSULeadership
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INTRO

COMPLIANCE

WCAG P.O.U.R.
PERCEIVABLE
OPERABLE
UNDERSTANDABLE

ROBUST

EXPERIENTIAL

VIDEOS
TEXT
CLOSING

MAKING A GRAPHIC-HEAVY EXPERIENCE ACCESSIBLE

IMPORTANT BEST PRACTICES: Adjust size/spacing/amount of content according to the device/context
upon which it will be viewed. Only link to accessible content. Make sure all informative content is

accessible then move on to compliance for entertaining content.

ON SOCIAL MEDIA

« Primarily viewed on mobile device, so keep graphic text to a minimum.
« Use UNDERSTANDABLE and inclusive language
« Test the color contrast of all foreground/background pairs.

« Add all pertinent information to the post itself rather than only on the graphic.

« Add descriptive alt-text

« Limit EMOJI and HASHTAG use and put at the end of posts.
« Use Camel Case for hashtags: #KentStateUniversity

« Do not create custom post fonts with Unicode.

IN DIGITAL CATALOGS OR COLLECTIONS

« Avoid “flipbooks” whenever possible. They are inherently inaccessible,
especially ISSUU.

« |f unavoidable, link to an accessible version. Whatever the user experience is
with a flipbook should be matched in the accessible version.

« Often a source pdf/indesign file is uploaded to create the flipbook — simply
make that source document accessible and available.

« Make sure images resize and respond appropriately on different sized
devices and displays.

ON A DIGITAL DISPLAY

Stand in the area where the monitor, TV,
or screen is housed. Step as close to
the display then as far away as
possible. Note the possible
environmental factors — poor screen
quality, bright sunlight, not-ideal viewing
location, fluorescent lighting. Adjust
your design accordingly. If one file will
be used in multiple locations, design
for the poorest conditions.

Use understandable and inclusive
language

Test the color contrast of all
foreground/background pairs.

Use large, readable fonts — KSU brand
fonts (National, Roboto, Source Sans,
Soho) Arial, Verdana, Tahoma, Century
Gothic, Trebuchet, Calibri, Open Sans.
Choose sans fonts whenever possible.



INTRO

COMPLIANCE

WCAG P.O.U.R.
PERCEIVABLE
OPERABLE
UNDERSTANDABLE

ROBUST

EXPERIENTIAL
IMAGES
VIDEOS
TEXT

CLOSING

MAKING A VIDEO EXPERIENCE ACCESSIBLE

IMPORTANT BEST PRACTICES: Adjust size/spacing/amount of content according to the device/context
upon which it will be viewed. Only link to accessible content. Make sure all informative content is

accessible then move on to compliance for entertaining content.

ON SOCIAL MEDIA

Primarily viewed on mobile device, so zoom in on faces and keep
text large and readable.

Think carefully about how to best caption. Set high captioning
standards for your department.

Make sure pause/stop/volume/caption controls are visible and
usable. Do not use platforms which cannot meet this requirement.

If content is informative in nature, add a link to the transcript at
the end of the post. (Or add to bio/link tree for Instagram)

WHEN RECORDED

Choose university-contracted platforms such as Microsoft Teams or
Canvas to ensure strong accessibility.

Enable live captioning within the recording platform. Test all
technological functionality beforehand if a human captioner is used.

Draw attention to captioning/interpreting at the beginning of the
event and use that time to promote accessibility.

Provide an edited/corrected transcript
Share only accessible slide presentations.

FOR A LIVE EVENT

Choose university-contracted platforms
such as Microsoft Teams or Canvas to
ensure strong accessibility.

Enable live captioning on your end. Test
all technological functionality
beforehand if a human captioner is
used.

Schedule an ASL interpreter for large-
scale and/or public events.

Draw attention to captioning and/or
interpreting at the beginning of the event
and use that time to promote
accessibility. Direct users to the
“Accessibility” link in any KSU website
footer to report an accessibility concern.

Provide an edited/corrected transcript
as soon as possible after the event.

Share only accessible slide
presentations.



INTRO

COMPLIANCE

WCAG P.O.U.R.
PERCEIVABLE
OPERABLE
UNDERSTANDABLE

ROBUST

EXPERIENTIAL
IMAGES
VIDEOS
TEXT

CLOSING

MAKING A TEXT-HEAVY EXPERIENCE ACCESSIBLE

IMPORTANT BEST PRACTICES: Adjust size/spacing/amount of content according to the device/context upon which
it will be viewed. Only link to accessible content. Make sure all informative content is accessible then move on to
compliance for entertaining content.

BLOGS, NEWSLETTERS, ARTICLES &
EMAILS

Use large, readable fonts — KSU brand fonts (National, Roboto,
Source Sans, Soho) Arial, Verdana, Tahoma, Century Gothic,

Trebuchet, Calibri, Open Sans. Choose sans fonts whenever possible.

Organize your content using HEADING STYLES not merely with
bold/underline formatting

Use the bullet/numbers option in the toolbar rather than tabbing to
indent or list. Bullets if no ranking/order.

Add image alt-text (or mark “decorative”).

Work diligently to reduce word count. Use clear, simple language that
is inclusive.

Avoid industry jargon, abbreviations, acronymns

Make sure content is easily scannable visually: plenty of white space,
solid organization and padding around images. Left align rather than
justified.

Name hyperlinks carefully. Descriptive but not tediously long.
Consider a button rather than a link when possible.

Do not send image-only emails. All text should be in the
paragraph/body and use page structure.

POLLS/SURVEYS

Only use platforms that have strong accessibility
features. Microsoft and Google forms are widely
recognized as accessible. Qualtrics requires
careful choice of features and customization of
some default features before it is strong
accessibly.

Construct your form to only display vertically — in
one long column or in one column spread among
several screens. Do not have questions extend
“below the fold”.

Questions that require physically moving a slider
or dragging and dropping an answer are largely
inaccessible.

Do not set time limits for answers and do not
enable automatic logging off after a short
duration.

Display a progress indicator at all times.

Have both a “previous”/"back” button as well as a
“next”/"continue” button on each screen. Do not
have only arrows as indicators. Always display a
way out for the user.





